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Introduction
This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described in the sections identified below.

• The below Displays are no longer sold nor maintained by Pro-face. To reduce 
unplanned downtime due to aged hardware and to maximize your cyber security 
environment we recommend replacing your devices with a new, successor model.
For details, please visit our homepage for "Recommended Substitution".
Discontinued from GP-Pro EX 5.00 onwards: GP3000 Series, LT3000 Series, 
ST3000 Series, GP-4100 Series (Monochrome model), PL Series, PS3000/4000 
Series, PE4000 Series.

• For details on the Displays supported by the driver, please check the "Connectable 
Devices" on our website.
http://www.pro-face.com/trans/en/manual/1064.html

1 System Configuration
This section lists the types of External 
Devices and SIO that you can connect.

"2 System Configuration" (page 4)

2 External Device Selection
Select the model (series) of the External 
Device and its connection method.

"3 External Device Selection" (page 6)

3 Communication Settings
This section shows setting examples for 
communicating between the Display and 
the External Device.

"4 Communication Setting" (page 7)

4 Setup Items
This section describes communication 
setup items on the Display.
Set the communication settings of the 
Display with GP-Pro EX or in offline mode.

"5 Setup Items" (page 25)

Operation

http://www.pro-face.com/trans/en/manual/1064.html
http://www.pro-face.com/trans/en/manual/1064.html
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1 General MODBUS TCP Master Driver

The general MODBUS TCP Master Driver is used to connect the Display to a MODBUS-compatible External 

Device for general purpose.

The function code and boundary required for communication can be changed according to the External Device.
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2 System Configuration

The system configuration in the case when the External Device and the Display are connected is shown.

• External Device used to confirm connection

 Connection Configuration

1:1 Connection

Series CPU Link I/F SIO Type Setting Example

MODBUS Slave Device*1

*1 To connect with External Device using the Modbus protocol, configure the [Device Setting] to match the spec-
ifications on the External Device.

 Setup Items (page 25)

Ethernet (TCP) Setting Example 1 
(page 7)

Series CPU Link I/F SIO Type Setting Example

Hitachi Industrial 
Equipment 
Systems Co., Ltd. 
MICRO-EHV

MVH-A64
MVH-D64
MVH-A40
MVH-D40

Ethernet port on basic unit
Ethernet (TCP) Setting Example 2 

(page 9)

Ethernet (TCP)
(Modbus Gateway)

Setting Example 3 
(page 11)

silex technology, 
Inc.
FBR-100AN

FBR-100AN
Ethernet port 1 on CPU Ethernet (TCP) Setting Example 4 

(page 13)

Ethernet port 2 on CPU Ethernet (TCP) Setting Example 4 
(page 13)

IAI CORPO-
RAT17ION.
RCON

RCON-GW/GWG-
-ET Ethernet port on CPU Ethernet (TCP) Setting Example 5 

(page 15)

RCON-PC-
RCON-PCF-
RCON-AC-
RCON-DC-
RCON-SC-

Ethernet port on 
RCON-GW/GWG--ET Ethernet (TCP) Setting Example 6 

(page 17)

FANUC 
CORPORATION
CNC

FANUC Series 
0i-MODEL F Plus

CD38R port on Fast Ethernet 
board of slot 1 Ethernet (TCP) Setting Example 7 

(page 19)

Embedded Ethernet port 
(CD38A) Ethernet (TCP) Setting Example 8 

(page 22)

Display External Drive

HUB
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1: n Connection

n: 1 Connection

Display External Drive

HUB

External Drive

Maximum 16 units

Display External Drive

HUB

Display

The number of connectable Displays
depends on the External Device.
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3 External Device Selection

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/
PLCs Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

Manufacturer Select the manufacturer of the External Device to connect. Select "Modbus-IDA".

Series

Select the External Device model (series) and the connection method. Select "General 
MODBUS TCP Master".
In System configuration, make sure the External Device you are connecting is supported by 
"General MODBUS TCP Master".

"2 System Configuration" (page 4)

Port Select the Display port to connect to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device (memory) 
of the External Device. When synchronized, you can use the External Device’s ladder program 
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area] 
Settings Guide"

Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"
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4 Communication Setting

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are 

shown.

4.1 Setting Example 1

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Notes

• Check with your network administrator about the IP address you want to use.

• Do not duplicate IP addresses on the same network.

• In [Individual Device Settings], set the IP address of the External Device.

• Set the Display’s IP address in offline mode.

 External Device Settings
External Device settings vary depending on the device. Refer to your External Device manual for details.

Notes

• Check with your network administrator about the IP address you want to use.

• Do not duplicate IP addresses on the same network.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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4.2 Setting Example 2

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Notes

• Check with your network administrator about the IP address you want to use.

• Do not duplicate IP addresses on the same network.

• In [Individual Device Settings], set the IP address of the External Device.

• Set the Display’s IP address in offline mode.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings (Ethernet port on basic unit)
Use the programming software (Control Editor) for communication settings. Please refer to the manual of the 

External Device for more details.

Procedure

1. Start the programming software and create a project. The project appears in offline mode.

2. In the tree view, from [CPU Parameters] double-click [CPU settings] and [IP address]. The [CPU 

Communication Setting (IP Address)] dialog box appears.

3. Set the following items and click [Set].

4. In the tree view, from [CPU Parameters] double-click [CPU settings] and [Modbus-TCP/RTU]. The [CPU 

communication settings (Modbus-TCP/RTU)] dialog box appears.

5. Set the following items and click [Set].

6. Enter online mode, and transfer the settings to the External Device.

7. Restart the External Device.

Notes

• Check with your network administrator about the IP address you want to use. Do not duplicate IP addresses 

on the same network.

Setup Items Setting

IP Address 192.168.0.1

Subnet mask 255.255.255.0

Default gateway 0.0.0.0

Link Speed / Duplex Auto Negotiation

Setup Items Setting Remarks

Port No. 502

Enable gateway OFF

Ethernet timeout 3000 Set to 0 when not using timeout.
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4.3 Setting Example 3

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Notes

• Check with your network administrator about the IP address you want to use.

• Do not duplicate IP addresses on the same network.

• In [Individual Device Settings], set the IP address of the External Device.

• Set the Display’s IP address in offline mode.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings (Ethernet port on basic unit)
Use the programming software (Control Editor) for communication settings. Please refer to the manual of the 

External Device for more details.

Procedure

1. Start the programming software and create a project. The project appears in the offline mode.

2. In the tree view, from [CPU Parameters] double-click [CPU settings] and [IP address]. The [CPU 

Communication Setting (IP Address)] dialog box appears.

3. Set the following items and click [Set].

4. In the tree view, from [CPU Parameters] double-click [CPU settings] and [Modbus-TCP/RTU]. The [CPU 

communication settings (Modbus-TCP/RTU)] dialog box appears.

5. Set the following items and click [Set].

•   Modbus-TCP Settings

• Modbus-RTU Settings

6. Enter online mode, and transfer the settings to the External Device.

7. Restart the External Device.

Notes

• Check with your network administrator about the IP address you want to use. Do not duplicate IP addresses 

on the same network.

Setup Items Setting

IP Address 192.168.0.1

Subnet mask 255.255.255.0

Default gateway 0.0.0.0

Link Speed / Duplex Auto Negotiation

Setup Items Setting Remarks

Port No. 502

Enable gateway OFF

Ethernet timeout 3000 Set to 0 when not using timeout.

Setup Items Setting Remarks

Serial com. Baudrate 115.2kbps Match the settings of Modbus Slave devices.

Serial com. Format 8-E-1 Data length: 8-bit, Even parity, Stop bit: 1-bit
Match the settings of Modbus Slave devices.

Serial com. Timeout 100 Set to 0 when not using timeout.
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4.4 Setting Example 4

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Notes

• Check with your network administrator about the IP address you want to use.

• Do not duplicate IP addresses on the same network.

• In [Individual Device Settings], set the IP address of the External Device.

• Set the Display’s IP address in offline mode.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use DIP switches and a web browser for defining communication settings. Please refer to the manual of the 

External Device for more details.

Procedure

1. Turn off all DIP switches on the External Device.

2. Open a web browser.

3. Enter the IP address in the address bar (default IP address on LAN Port1: 192.168.1.1).

4. Create a new password and click [Submit].

5. Enter the password and click [Login].

6. Click [General] from [Network Conf.].

7. Set the following and click [Submit].

8. Click [Modbus TCP] from [Network Conf.].

9. Set the following and click [Submit].

Notes

• Check with your network administrator about the IP address you want to use. Do not duplicate IP addresses 

on the same network.

Setup Items Setting Remarks

LAN 
Port1

DHCP Client Enable Set the DHCP client to be enabled or disabled.

IP Address 192.168.1.10 Enter the IP address.

Sub Net Mask 255.255.255.0 Enter the subnet mask.

Setup Items Setting Remarks

Modbus TCP Port 502 Use an integer from 0 to 32767 to specify the Modbus TCP 
port number. This is the same port number as the Display.

• When using Ethernet port 2, replace LAN Port1 in procedure 7 with LAN Port2.
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4.5 Setting Example 5

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Notes

• Check with your network administrator about the IP address you want to use.

• Do not duplicate IP addresses on the same network.

• In [Individual Device Settings], set the IP address of the External Device.

• Set the Display’s IP address in offline mode.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the MODE selector switch on the RCON-GW and the Parameter Configuration Tool in the IAI GateWay Unit 

Software for defining communication settings. Please refer to the manual of the External Device for more details.

Procedure

1. On the RCON-GW, connect to the USB port.

2. Set the RCON-GW’s MODE selector switch to "MANU".

3. Start the Parameter Configuration Tool.

4. From SelectGwType, select "RCON".

5. Click [Port Config] to set the COM port to use for communication.

6. Click [OK].

7. Click [Read].

8. Click [Ethernet connection setting] from [Setting] menu.

9. Set the IP address of the CPU and click [OK].

10. Click [Write].

Notes

• Check with your network administrator about the IP address you want to use. Do not duplicate IP addresses 

on the same network.
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4.6 Setting Example 6

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Notes

• Check with your network administrator about the IP address you want to use.

• Do not duplicate IP addresses on the same network.

• In [Individual Device Settings], set the IP address of the External Device.

• Set the Display’s IP address in offline mode.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the MODE selector switch on the RCON-GW and the Parameter Configuration Tool in the IAI GateWay Unit 

Software for defining communication settings. Please refer to the manual of the External Device for more details.

Procedure

1. On the RCON-GW, connect to the USB port.

2. Set the RCON-GW’s MODE selector switch to "MANU".

3. Start the Parameter Configuration Tool.

4. From SelectGwType, select "RCON".

5. Click [Port Config] to set the COM port to use for communication.

6. Click [OK].

7. Click [Read].

8. Click [Ethernet connection setting] from [Setting] menu.

9. Set the IP address of the CPU and click [OK].

10. Click [Detail setting].

11. From the Axis No.assgnmt / unit config, click [Manual].

To change the axis number assignment and edit the driver unit, click [Change].

12. Set the axis number assignment and click [OK].

13. Click [Write].

Notes

• Check with your network administrator about the IP address you want to use. Do not duplicate IP addresses 

on the same network.
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4.7 Setting Example 7

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Notes

• Check with your network administrator about the IP address you want to use.

• Do not duplicate IP addresses on the same network.

• In [Individual Device Settings], set the IP address of the External Device.

• Set the Display’s IP address in offline mode.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Set the communication settings for the External Device on the CNC screen.

Please refer to the manual of the External Device for more details.

Procedure

1. Turn on the power of CNC.

2. Press the function key [SYSTEM] to display the parameter setting screen.

3. Enter “9”, “7”, and “0” using the numeric keys.

4. Press soft key [No. SEARCH].

5. Enter the following values for each parameter and press the [INPUT] key.

6. Enter “1”, “4”, “8”, “8”, and “2” using the numeric keys.

7. Press the soft key [No. SEARCH].

8. Set the bit 1 to “0”.

9. Restart the CNC. If the alarm (PW0050) appears, restart the CNC again.

10. After restarting, press the function key [SYSTEM].

11. Press the [<] or [>] button on the screen until the soft key [ETHERNET] appears.

12. Press the soft key [ETHERNET].

13. Enter the following values for each item and press the [INPUT] key.

14. Find the soft key [Modbus SET].

15. Press the soft key [Modbus SET].

16. Set each item and press the [INPUT] key.

Parameter No. Setting Remarks

970 3 Uses the Modbus/TCP server.

971 -1 Does not use the FL-net function.

972 -1 Does not use the FL-net PORT2 function.

973 -1 Does not use the PROFINET IO device function.

974 -1 Does not use the PROFINET IO controller function.

975 -1 Does not use the EtherNet/IP function.

976 -1 Does not use the EtherNet/IP function.

Setup Items Setting Remarks

IP Address 192.168.1.1 Enter the IP address.

SUBNET 
MASK 255.255.255.0 Enter the subnet mask.

ROUTER IP 
ADDRESS Blank Enter the router IP address.

DHCP 
CLIENT 0

Enter the DHCP setting. (Value set in parameter 904#6.)
0: Disable DHCP function.
1: Enable DHCP function.

Setup Items Setting Remarks

PORT NUMBER 
(TCP) 502 Enter the Modbus TCP port number.
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17. Press the page change key [PAGE DOWN].

18. Set the PMC address to be assigned to the Modbus address and press the [INPUT] key. (AREA1)

19. To assign a PMC address to another Modbus address, prepare AREA2 or AREA3 for similar settings.

20. Restart the CNC.

Notes

• Check with your network administrator about the IP address you want to use. 

• Do not duplicate IP addresses on the same network.

OPTION 1 RSV: 0
BCE: 0

RSV: Do not change the setting.
BCE: Enter little endian (0) or big endian (1).

STATUS PMC 
ADDRESS Any address To save the status value, specify any device and address. This 

area uses 1 byte for addressing.

Setup Items Setting Remarks

DATA Modbus 
ADDRESS 1 Enter the Modbus start address (Holding register) for the link to 

the PMC address. Setting range is 1 to 65536.

DATA PMC 
ADDRESS Any address Enter the PMC start address (E or D or R device) for the link to 

the Modbus address. Enter an even number of addresses.

DATA SIZE 
(WORD) 100

Enter the size to be used for the link area size. This size depends 
on the valid range of PMC addresses. If no link is needed, enter 
0.

Setup Items Setting Remarks
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4.8 Setting Example 8

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Notes

• Check with your network administrator about the IP address you want to use.

• Do not duplicate IP addresses on the same network.

• In [Individual Device Settings], set the IP address of the External Device.

• Set the Display’s IP address in offline mode.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Set the communication settings for the External Device on the CNC screen.

Please refer to the manual of the External Device for more details.

Procedure

1. Turn on the power of CNC.

2. Press the [Home menu] button on the keyboard.

3. Press the function key [SYSTEM].

4. Enter “1”, “4”, “8”, “8” and “2” using the numeric keys.

5. Press the soft key [No. SEARCH].

6. Set the bit 1 to “1”.

7. Restart the CNC.

8. After restarting, perform procedures 2 to 4.

9. Press the [<] or [>] buttons on the screen until the soft key [EMBED PORT] appears.

10. Press the soft key [EMBED PORT].

11. Enter the following values for each item and press the [INPUT] key.

12. Find the soft key [Modbus SET].

13. Press the soft key [Modbus SET].

14. Set each item and press the [INPUT] key.

15. Press the [PAGE DOWN] key on the keyboard.

16. Set the PMC address to be assigned to the Modbus address and press the [INPUT] key. (AREA 1)

Setup Items Setting Remarks

IP Address 192.168.1.1 Enter the IP address.

SUBNET 
MASK 255.255.255.0 Enter the subnet mask.

ROUTER IP 
ADDRESS Blank Enter the router IP address.

DHCP 
CLIENT 0

Enter the DHCP setting. (Value set in parameter 904#6.)
0: Disable DHCP function.
1: Enable DHCP function.

Setup Items Setting Remarks

PORT NUMBER 
(TCP) 502 Enter the Modbus TCP port number.

OPTION 1 RSV: 0
BCE: 0

RSV: Do not change the setting.
BCE: Enter little endian (0) or big endian (1).

STATUS PMC 
ADDRESS Any address To save the status value, specify any device and address. This 

area uses 1 byte for addressing.

Setup Items Setting Remarks

DATA Modbus 
ADDRESS 1 Enter the Modbus start address (Holding register) for the link to 

the PMC address. Setting range is 1 to 65536.

DATA PMC 
ADDRESS Any address Enter the PMC start address (E or D or R device) for the link to 

the Modbus address. Enter an even number of addresses.
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17. To assign a PMC address to another Modbus address, prepare AREA2 or AREA3 for similar settings.

18. Restart the CNC.

Notes

• Check with your network administrator about the IP address you want to use. 

• Do not duplicate IP addresses on the same network.

DATA SIZE 
(WORD) 100

Enter the size to be used for the link area size. This size depends 
on the valid range of PMC addresses. If no link is needed, enter 
0.

Setup Items Setting Remarks
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5 Setup Items

Set up the Display’s communication settings in GP-Pro EX or in the Display’s offline mode.

The setting of each parameter must match that of the External Device.

"4 Communication Setting" (page 7)

5.1 Setup Items in GP-Pro EX

 Communication Settings
To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

• Set the Display’s IP address in offline mode.

Cf. Maintenance/Troubleshooting Guide "Ethernet Settings"

Setup Items Setup Description

Port No. Use an integer from "1024 to 65535" to enter the port number of the Display. If you check 
[Auto], the port number will be automatically set.

Timeout Use an integer from 1 to 127 to enter the time(s) for which the Display waits for the 
response from the External Device.

Retry In case of no response from the External Device, enter how many times the Display 
retransmits the command, from "0 to 255".

Wait To Send Enter the standby time (ms) from when the Display receives packets until it transmits the 
next command, from "0 to 5000".

• Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 
Device)"
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 Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

• [Equipment Configuration] Tab

Setup Items Setup Description

IP Address

Set the IP address of the External Device.

• Check with your network administrator about the IP address you want to 
use.

• Do not duplicate IP addresses on the same network.

Port No. Use an integer from "1 to 65535" to enter the port number of the External 
Device.

Unit ID Use an integer from 1 to 247 (or 255) to enter the unit ID of the External 
Device.

Bit manipulation (set/reset) to 
Holding Register Select how other bits in the same word are handled when you manipulate bits in 

the holding register, from "Clear" or "Do not clear".Rest of the bits in 
this word

IEC61131 Syntax Select this item to use the IEC61131 syntax for variables.
If you check this item, select the address mode from "0-based" or "1-based".

Double Word word order Select the order of storing double word data from "Low word first" or "High 
word first".

Import
Import the device settings described in the xml file.

"  Import Procedure in the Device Setting" (page 30)

Export
Export the device settings into the xml file.

"  Export Procedure in the Device Setting" (page 30)
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• [Function Code and Max Query] Tab (when "Auto adjust to frame length" is selected)

Setup Items Setup Description

Auto adjust to frame length
Automatically set each function code and the boundary for one 
communication according to the frame length.
Function codes cannot be changed. To change a function code, use "Custom".

Frame Length Set the frame length from "10 to 258".
After setting, click the device list to display the boundary.

Import
Import the device settings described in the xml file.

"  Import Procedure in the Device Setting" (page 30)

Export
Export the device settings into the xml file.

"  Export Procedure in the Device Setting" (page 30)

• When "Auto adjust to frame length" is selected, use the following function codes. The read/
write boundary is automatically calculated according to "Frame Length".

• Use "Custom" in the following cases:
• When you use a different function code depending on an address.
• When you use the function code "05: Force Single Coil" or "06: Preset Single Register".
• When the read/write boundary depends on the device.

Device
Function Code

Read Write

Coil 01 0F: Force Multiple Coils

Discrete Input 02 Disabled

Input Register 04 Disabled

Holding Register 03 10: Preset Multiple Register
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• [Function Code and Max Query] Tab (when "Custom" is selected)

Setup Items Setup Description
Custom Manually set each function code and the boundary for one communication.

Add
Add the function code and its data boundary settings.
Up to 20 settings can be added.
Add the settings in the [Add setting] dialog box.

Configuration Change the selected device settings.
Change the settings in the [Configuration setting] dialog box.

Delete Delete the selected device settings.

Import
Import the device settings described in the xml file.

"  Import Procedure in the Device Setting" (page 30)

Export
Export the device settings into the xml file.

"  Export Procedure in the Device Setting" (page 30)
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• [Add setting] Dialog Box / [Configuration setting] Dialog Box

Setup Items Setup Description
Start Address Set the start address of the device.

Range Set the range of the device specified in the start address.

Read Set the function codes to be used for read and the read boundary in one 
communication.

Function Code The function code is assigned by the specified start address.

Boundary The boundary depends on the device. Refer to the following table for details.

Write Set the function code to be used for write and the write boundary in one 
communication.

Function Code The function code depends on the device. Refer to the following table for 
details.

Boundary The boundary depends on the device. Refer to the following table for details.

• When "Custom" is selected, use the following function codes.

• If the set device address is disabled to write, you cannot set the write function code and 
boundary.

• When you select the function code "05" or "06", the write boundary will be fixed to "1", and 
cannot be changed.

Device

Function Code (Boundary)

Read
Write

Multiple Single

Coil 01(2000) 0F: Force Multiple Coils (800) 05: Force Single Coil (Fixed to 1)

Discrete Input 02(2000) Disabled Disabled

Input Register 04(125) Disabled Disabled

Holding Register 03(125) 10: Preset Multiple Register 
(100) 06: Preset Single Register ( Fixed to 1)



General MODBUS TCP Master Driver

GP-Pro EX Device/PLC Connection Manual 30

 Import Procedure in the Device Setting

1 Create the xml file based on the following format sample.

• Format sample when "Auto adjust to frame length" is selected

• Format sample when "Custom" is selected

2 Click [Import] on the [Individual Device Settings] dialog box to display the [Open] dialog box.

3 Select the created xml file and click [Open].

Export Procedure in the Device Setting

1 Click [Export] on the [Individual Device Settings] dialog box to display the [Save as] dialog box.

2 Enter a name and click [Save].
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5.2 Setup Items in Offline Mode

Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the 

External Device you want to set from the displayed list.

• Refer to the Maintenance/Troubleshooting guide for information on how to enter offline mode 
or about the operation.

Cf. Maintenance/Troubleshooting Guide "Offline Mode"

• The number of the setup items to be displayed for 1 page in the offline mode depends on the 
Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

Port No.

Set the Port No. of the Display.
Select either of [Fixed] or [Auto]. When you select [Fixed], use an integer from "1024 to 
65535" to enter the port number of the Display.When you select [Auto], the port number 
will be automatically assigned regardless of the entered value.

Timeout Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry In case of no response from the External Device, enter how many times the Display 
retransmits the command, from "0 to 255".

Wait To Send Enter the standby time (ms) from when the Display receives packets until it transmits the 
next command, from "0 to 5000".
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Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device 

you want to set from the displayed list, and touch [Device].

(Page 1/22)

Setup Items Setup Description

Device/PLC Name Select the External Device to set. The device name is the title of the External 
Device set with GP-Pro EX.(Initial value [PLC1])

IP Address

Set the IP address of the External Device.

• Check with your network administrator about the IP address you want to use.
• Do not duplicate IP addresses on the same network.

Port No. Use an integer from "1 to 65535" to enter the port number of the External Device.

Unit ID Use an integer from 1 to 247 (or 255) to enter the unit ID of the External Device.

Bit manipulation to HR
Displays how other bits in the same word are handled when you manipulate bits in 
the holding register, as "Rest of bits in word are cleared" or "Rest of bits in word 
are not cleared". (Not available to set in offline mode.)

Double Word word order Displays the currently set order of storing double word data as "Low word first" or 
"High word first". (Not available to set in offline mode.)

IEC61131 Syntax Displays the usage status of the currently set IEC61131 syntax in ON/OFF. (Not 
available in offline mode.)
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(Page 2/22)

Setup Items Setup Description

Device/PLC Name Select the External Device to set. The device name is the title of the External 
Device set with GP-Pro EX.(Initial value [PLC1])

Function Code and Max Query Displays the option to set the function code and boundary. (Not available to 
set in offline mode.)

Auto adjust Setting Displays the set frame length when "Auto adjust to frame length" is selected 
in the online mode. (Not available to set in offline mode.)Frame Length

• When "Custom" is selected, the setup items of the frame length are invalid.
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(Page 3/22 to 22/22)

Setup Items Setup Description

Device/PLC Name Select the External Device to set. The device name is the title of the External 
Device set with GP-Pro EX. (Initial value [PLC1])

Start Address Displays the start address of the device. (Not available to set in offline mode.)

Range Displays the range of the device specified in the start address. (Not available to set 
in offline mode.)

Read Displays the device function codes and boundaries to be read for one 
communication. (Not available to set in offline mode.)

Write Displays the device function codes and boundaries to be written for one 
communication. (Not available to set in offline mode.)

• Page 3 and the following pages display the set descriptions in order.
• When "Auto adjust to frame length" is selected, the Custom setup items are invalid.
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6 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of 

the devices varies depending on the External Device to be used. Please check the actual range in the manual of 

your External Device.

6.1 MODBUS Slave Device

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Coil 000001 - 065536 000001 - 065521

or

*1

*1 Whether the data is stored as higher or lower is determined by the [Double Word word order] setting in [Device
Setting].
"5.1 Setup Items in GP-Pro EX" (page 25)

 

Discrete Input 100001 - 165536 100001 - 165521  *2

*2 Write disable.

Input Register ----- 300001 - 365536  *2

Holding Register 400001,00 - 
465536,15 400001 - 465536  *3

*3 An access method at the time of Bit Set varies depending on the [Rest of the bits in this word] setting of [Device
Setting].

"Clear"........................................

"Do not clear"............................. 400001,00 - 465536,15

Input Register ----- D300001 - D365535  *2

Holding Register D400001,00 - 
D465535,31 D400001 - D465535  *4

*4 An access method at the time of Bit Set varies depending on the [Rest of the bits in this word] setting of [Device
Setting].

"Clear"........................................

"Do not clear"............................. D400001,00 - D465535,31

• GP-Pro EX simulation does not synchronize the coil bit address and word address values.
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 IEC61131 Syntax Address Description
The following table compares IEC61131 and MODBUS syntax address descriptions.

Device

MODBUS Syntax IEC61131 Syntax

Format

0-based 1-based

Format Range
First 

element
Range

First 
element

Range
First 

element

Coil 000001+i i = 0 to 
65535 000001 %Mi i = 0 to 

65535 %M00000 i = 1 to 
65536 %M00001

Discrete Input 100001+i i = 0 to 
65535 100001 - - - - -

Input Register 
(Word) 300001+i i = 0 to 

65535 300001 - - - - -

Input Register 
(Word bit) 300001+i,j

i = 0 to 
65535
j = 0 to 
15

300001,00 - - - - -

Holding 
Register 
(Word)

400001+i i = 0 to 
65535 400001 %MWi i = 0 to 

65535 %MW00000 i = 1 to 
65536 %MW00001

Holding Register 
(Word bit) 400001+i,j

i = 0 to 
65535
j = 0 to 
15

400001,00 %Mwi:
Xj

i = 0 to 
65535
j=0 to 15

%MW00000
:X00

i = 1 to 
65536
j=0 to 15

%MW00001
:X00

Input Register 
(D Word) D300001+i i = 0 to 

65534 D300001 - - - - -

Input Register 
(D Word bit) D300001+i,j

i = 0 to 
65534
j = 0 to 
31

D300001,00 - - - - -

Holding 
Register (D 
Word)

D400001+i i = 0 to 
65534 D400001 %MDi i = 0 to 

65534 %MD00000 i = 1 to 
65535 %MD00001

Holding Register 
(D Word bit) D400001+i,j

i = 0 to 
65534
j = 0 to 
31

D400001,00 %MDi:Xj
i = 0 to 
65534
j=0 to 31

%MD00000
:X00

i = 1 to 
65535
j=0 to 31

%MD00001
:X00

• The addresses 100000 and 300000 cannot be accessed using IEC61131 syntax.
• If you apply IEC61131 syntax to a project that has a discrete input or input register already set, 

the addresses become "-Undefined-" and invalid.

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.2 MICRO-EHV Series

: This address can be specified as system data area.

If you use Control Editor's I/O Monitor to monitor Modbus devices, use the following supported 
addresses table when specifying addresses.

Device Bit Address Word Address 32 bits Remarks

Coil 000257 - 00288 000257 - 000273  

Discrete Input 100001 - 100047 100001 - 100002 *1

*1 Write disable

Input Register ----- 300001 - 302048 *1

Holding Register 400001.00 - 
432768.15 400001 - 432768

Input Register ----- D300001 - D302047 *1

Holding Register D400001.00 -
D432767.31 D400001 - D432767

Modbus Device External Device

Device Range Device Range

Coil 000257 - 00288 External output Y0100 - Y0131

Discrete Input 100001 - 100048 External input X0000 - X0047

Input Register 300001 - 302048 Data area WM000 - WM7FF

Holding Register 400001 - 432768 Word inner output WR0000 - WR7FFF

Input Register D300001 - D302047 Data area DM000 - DM7FE

Holding Register D400001 - D432767 Word inner output DR0000 - DR7FFE

• GP-Pro EX simulation does not synchronize the coil bit address and word address values.
• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.3 FBR-100AN Series

: This address can be specified as system data area.

Device Bit Address Word Address 32 bits Remarks

Input Register

----- 300001 - 300088
or

*1

*1 Whether the data is stored as higher or lower is determined by the [Double Word word order] setting in [Device
Setting].

"5.1 Setup Items in GP-Pro EX" (page 25)

 *2 *3

*2 Write disable

*3 Modbus address map:

----- D300001 - D300087  *2 *3

• GP-Pro EX simulation does not synchronize the coil bit address and word address values.
• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

Overview Modbus address Word number Remarks

CNC Series 300001 - 300064 64 words String

PMC number of strains 300065 - 300072 8 words String (Value)

CNC number of strains 300073 - 300080 8 words String (Value)

Status 300081 - 300088 8 words Available or unavailable
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6.4 RCON Series

: This address can be specified as system data area.

Device Bit Address Word Address 32 bits Remarks

Device0:
Coil 000001 - 065536 000001 - 065521

Device1:
Discrete Input 100001 - 165536 100001 - 165521  *1

*1 Write disable

Device3:
Input register ----- 300001 - 365536  *1

Device4:
Holding register 400001.00 - 465536.15 400001 - 465536  

• GP-Pro EX simulation does not synchronize the coil bit address and word address values.
• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.5 FANUC Series 0i-MODEL F Plus

: This address can be specified as system data area.

Device Bit Address Word Address 32 bits Remarks

4(Holding Register) 400001.00 - 465536.15 400001 - 465536 *1

*1 The R, E and D areas of the PMC address can be assigned to the Modbus address; refer to FANUC's PMC
programming manual (B-64513EN) for the PMC address range.

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7 Device Code and Address Code

Use device code and address code when you set "Device Type & Address" for the address type of the data display 

or other devices.

Device Device Name
Device Code

(HEX)
Address Code

Coil 0 0080 Value of (word address -1) divided by 16

Discrete Input 1 0081 Value of (word address -1) divided by 16

Input Register 3 0001 Value of (word address - 1)

Holding Register 4 0000 Value of (word address - 1)

Input Register D3 0002 Value of (word address -1) divided by 2

Holding Register D4 0003 Value of (word address -1) divided by 2



General MODBUS TCP Master Driver

GP-Pro EX Device/PLC Connection Manual 42

8 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA035: PLC1: Error has been responded for device write command (Error Code: 2[02H])"

 Error Codes Specific to the External Device
Please refer to the manual of the External Device for error codes specific to the External Device.

General MODBUS error codes are shown below.

Item Description

No. Error Number.

Device Name Name of the External Device where an error has occurred. The Device name is the title of 
the External Device set with GP-Pro EX.(Initial value [PLC1])

Error Message Displays messages related to an error that has occurred.

Error Occurrence Area

Displays the IP address or device address of the External Device where an error has 
occurred, or error codes received from the External Device.

• IP address is displayed as "IP address (Decimal): MAC address (Hex)".
• Device address is displayed as "Address: Device address".
• Received error codes are displayed as "Decimal [Hex]".

• Refer to your External Device manual for details on received error codes.
• Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the 

error messages common to the driver.

Error Code
(HEX)

Description

01 Does not support the corresponding Function Code.

02 The specified data address does not exist.

03 Data value error.
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 Error Messages Specific to the External Device

ID Error Message Description

RHxx128 (Node Name): (Device Address) can't be read 
because of the limitation of the Read boundary

When reading the coil or discrete input as a 
word address while the boundary is less 
than 16 bits, or accessing the input or 
holding register as a double word while the 
boundary is set to 1 word, an error will be 
displayed.

RHxx129
(Node Name): (Device Address) can't be 
written because of the limitation of the Write 
boundary

When writing the coil as a word address 
while the boundary is less than 16 bits, or 
accessing the holding register as a double 
word while the boundary is set to 1 word, 
an error will be displayed.

RHxx130 (Node Name): (Device Address) is not defined 
on Function Code and Max Query setting

When accessing the device out of the 
defined area, an error will be displayed.

RHxx131
(Node Name): (Device Address) can't be read 
because of the limitation of the Device Range 
setting

When reading the coil or discrete input as a 
word address while the range is less than 16 
bits, or accessing the input or holding 
register as a double word while the range is 
set to 1 word, an error will be displayed.

RHxx132
(Node Name): (Device Address) can't be 
written because of the limitation of the Device 
Range setting

When writing the coil as a word address 
while the range is less than 16 bits, or 
accessing the holding register as a double 
word while the range is set to 1 word, an 
error will be displayed.
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